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What is the full form of NCBI ?

(A) National
Biotechnology Information

Center for

(B) National Council for Biological

Integration

(C) National Center for

Bioinformatics and Innovation

(D) National

Bioinformatics

Committee for

What is the main use of the KEGG

database ?

(A) Storing financial data

(B) Analyzing metabolic pathways
and interactions

(C) Designing graphics

(D) Conducting statistical analysis

Which tool is commonly used for

genome annotation ?

(A) Artemis
(B) Adobe Photoshop
(C) AutoCAD

(D) Excel
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Which bioinformatics tool is used to

visualize protein structures ?

(A) MEGA
(B) BLAST
(C) PyMOL
(D) Clustalw

Which of the following tools is used

for multiple sequence alignment ?

(A) Clustal Omega
(B) MS Word

(C) MATLAB

(D) SPSS

What is the primary function of the

BLAST tool in bioinformatics ?

(A) Sequence alignment and

similarity search

(B) Image editing
(C) Spreadsheet calculation

(D) Database management
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Which software is widely used for

constructing phylogenetic trees ?

(A) ClustalwW
(B) MEGA
(C) BLAST
(D) RASMOL

Which of the following is a commonly

used tool for sequence alignment ?

(A) BLAST
(B) Excel

(C) Photoshop
(D) AutoCAD
Which

database is  specifically

designed  for  storing  protein

structures ?

(A) GenBank
(B) PDB (Protein Data Bank)
(C) KEGG

(D) UniGene
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(A) TETEE (Prosite)
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(C) THiEst (PDB)

(D) &7 (KEGG)
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10.

11.

12.

Which database integrates information
from multiple sources to provide
functional  analysis of  protein
families ?

(A)
(B)
(©)
(D)

Prosite
GenBank
PDB
KEGG

What
database from primary and secondary

distinguishes a composite

database ?

(A) It stores only financial data.

(B)

It combines data from multiple

sources.

(©)

It is used for video editing.

(D)

It does not contain biological

data.

Which of the following is a secondary
biological database ?

(A) NCBI
(B)
(€)

(D)

EMBL
PDB

UniProt

Set-D



13.

14.

15.
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B170602T (6)

What type of information is typically
stored in a secondary database ?

(A) Raw sequence data

(B) Annotations and interpretations

of primary data

(C) Financial data

(D) Multimedia files

Primary  databases are  mainly

responsible for storing which type of

data ?

(A) Analyzed data

(B) Mathematical models
(C) Software code

(D) Raw experimental data

Which of the following is an example

of a primary biological database ?

(A) Swiss-Prot
(B) GenBank
(C) Prosite

(D) KEGG
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(A) BioPerl
(B)
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BioJava
BioR
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16.

17.

18.

What
biological database ?

is the main purpose of a

(A) Storing financial records

(B) Storing and

biological data

organizing

software

(©)

Developing appli-

cations

(D)

Creating multimedia content

Which of the following is a widely used
bioinformatics library implemented in
Python for sequence analysis and
biological data processing ?

(A) BioPerl
(B)
(©)

(D)

BioJava
BioR
BioPython

Which language is known for its use in

scripting and text processing in

bioinformatics ?

(A) Perl
(B) COBOL
(C) FORTRAN

(D) SQL
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20.

21.

SR RiHfeR | Ja-3meia STy
& farfgd 3 & fau TR W
HIA-HT TS ST HI Sl T 2

(A)

(B)

(C) S

(D) et

IRt H S HgeRE  $iR
fowem & fou ffafed § 9 s@-
G 9T SAT9ek ®9 9 IYAN ohI
STt € 2

(A) SaTfEre

(B) A

(C) HTML
(D) TaEw

IEERHCF U Wi A 3R
29 fagowm & fau sH-d@ qofEn
AT Horl 3T7eh STANT i Sl § 2

(A)
(B)

©)
(D) R

Python
Java

C++

B170602T
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19.

20.

21.

In bioinformatics, which language is
commonly used for developing web-

based applications ?

(A)
(B)
(©)
(D)

Ruby
Perl
Java

PHP

Which of the following programming
languages is known for its extensive
for data

use In bioinformatics

manipulation and analysis ?

(A) JavaScript

(B)

(©)
(D)

Python

HTML
Swift

Which programming language is most
widely used for statistical computing

and data analysis in bioinformatics ?

(A) Python
(B)
(©)
(D) R

Java

C++
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23.

24,

o o
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RN,
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22.

23.

24,

Which of the following techniques is

commonly  applied to study

small-molecule metabolites in

metabolomics ?

(A) Nuclear
(NMR) Spectroscopy

Magnetic Resonance

Chain  Reaction

(B)

Polymerase
(PCR)

(C) ELISA

(D) Western Blot

Metabolomics is concerned with the
study of which of the following ?

(A) Lipid profiles in organisms

(B) Metabolites within cells

(C) Protein interactions

(D) Genetic mutations

Which method is commonly used in

proteomics to identify proteins in a

sample ?

(A) Gel electrophoresis
(B) Chromatography
(C) Mass spectrometry

(D) Spectrophotometry
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25. WEiehfaeg fegen o2 M W steaem 25.  Proteomics is the large-scale study of

. what ?

(A) fafued (A) Lipids

(B) FEEESH (B) Carbohydrates
(C) fokeTeh TrSH (C) Nucleic acids
(D) U (D) Proteins

26. <A oIyt &l HWUA & fauw 26.  Which technique is often used in

transcriptomics to measure gene

IafRCIted § SRR fohg qohieh o
expression ?

ST fopan STan § 2

(A) I=A sdffen (A) Western blotting

(B) I THRMI (B) Mass spectrometry

(C) IRUAT it (RNA-seq) (C) RNA sequencing (RNA-seq)
(D) ELISA (D) ELISA

27. ;igrqqldmw fefafea O 9 fegent 27. Transcriptomics focuses on the study

I F@ © ? of which of the following ?

(A) U 3R 3Tt T (A) Proteins and their structures
(B) STRUAT THfcheH (B) RNA transcripts

(C) wIf¥TeRIsTl H Herdiased (C) Metabolites in cells

(D) Tafre dveom (D) Lipid synthesis
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28. SHIHRT H 3THdR W {9 dedrs & 28.  Which of the following technologies is

commonly used in genomics ?

ST foran ST § 2

(A) - Thedms] (A) X-ray crystallography

(B) Vo= SIMEM HigataT (NGS) (B) Next-generation sequencing
(NGS)

(C) deimS == RTaR™ (PCR) (C) Polymerase chain  reaction
(PCR)

(D) SR HISshIEhIdl (D) Electron microscopy

29. ST &1 &3 fHgT AsmaT wn 29. What does the field of genomics

$9 study ?

(A)  SHEE & G SR wrE (A) The structure and function of
genomes

(B) TEMah Wfafshanedi # STu[sii &1 (B) The behavior of molecules in

TR chemical reactions

(C) =it & Wi o (C) The physical properties of
materials

(D) el ST IR o (D) The anatomy of plants

30. foefafed § ¥ =9-91 339 fefaea 30. Which of the following devices

converts digital signals to analog

Gehdl I TATAN Hehdl H aRAfdd hial _

signals ?
g2
(A) wieH (A) Modem
(B) Hr=H (B) Mouse
(C) uHuweEt (C) SSD
(D) firx (D) Printer

B170602T (11) Set-D



31.

32.

33.

B170602T

Microsoft Word T TR & Hiweaat
1 [/ ?

(A) ATRfT o= e

(B) TfTehs™ Wi

(C) wHIR

(D) foww Ffefad

ffafed § ¥ ®F sAfcdd ©RS
e 1 /AT ?

(A)  FTE TR g

(B) <EretEt

(C) THTHE

(D) ardt feen

FHX TEEA § RAM T T A9 1
€7

(A) TeH g qEk

(B) e wHHg HE{

(C) e ww AR

(D) TTE-TrEH g 79l

(12)

31.

32.

33.

Microsoft Word is an example of

which type of software ?

(A) Operating system software

(B) Application software

(C) Firmware

(D) System utility

Which of the following is an example

of optical storage media ?

(A) USB Flash Drive

(B) DVD

(C) SSD

(D) Floppy Disk

What does RAM stand for in computer

terminology ?

(A) Random Access Memory
(B) Read Access Memory
(C) Rapid Access Memory

(D) Real-time Access Memory
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34.

35.

B170602T

Excel T "SUM" HeRM R hidl § ?

(A) Tem FHT g i g
(B) ¥eH I TH A0 H HA
SIS

(C) Soft § Tod BreT Hed U

(D) gft H ad gl Yo Urdl ¥ |

Excel § Combo Chart &1 39 foRdeh

o foman ST € 2

(A) T & =R § fafa= g&R & =i
EHNCICTE]

(B) T =i & o= oy fe@m

(C) =1 &I Wi (columns) & &9 H

I

(D) 3TU ! AR & H fe@m

(13)

34.

35.

What does the “SUM” function in

Excel do ?

(A) Counts the number of cells

(B) Adds up the values in a range of

cells

(C) Finds the smallest value in a

range

(D) Finds the largest value in a range

Combo Chart in Excel is used for :

(A) Displaying multiple chart types

within a single chart

(B) Plotting relationships between

two variables

(C) Representing data using vertical

bars

(D) Showing proportions in a

circular form
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36. Excel # fpdt 97 § Sy 2y 4 & 36.

g “Te” Hoft T W R BAA T 2

(A) T AfFa & )

(B) wfsha et STTel Shle™ | el S

Tl

(C) wfeha T 37Telt Uf | el S

Tl
(D) WfHa A T 1 B2 AT & |

37. ffafea & @ =@ fgdas RS 37.

SUHTTT 1 GHR T 2
(A) ™

(B) W

(C) = fem=n
(D) iRy

38. fr=fafed § § &M TH TAAM-2- 38.

fefSeet EUTaTu STHTUT h ISR § ?
(A) HEETER

(B) TR

© it

(D) firx

B170602T (14)

What happens when you press the
“Enter” key after typing data into a

cell in Excel ?

(A) The cell remains active.

(B) The active cell moves to the next

column.

(C) The active cell moves to the next

row.

(D) The active cell deletes the

content.

Which of the following is a type of

secondary storage device ?

(A) RAM

(B) ROM

(C) Hard Disk

(D) CPU

Which of the following is an example

of an analog-to-digital conversion

device ?

(A) Microphone
(B) Speaker
(C) Monitor

(D) Printer

Set-D



39.

40.

41.

B170602T

Excel § UMl & Th A0 1 3iEq

frprem & fau ®F-T1 weRE 39Em
foren ST & ?

(A) SUM

(B) COUNT

(C) AVERAGE
(D) MAX

Excel § Scatter Chart T H&d I9dn

ferereh foru fopan ST © 2

(A) SRl & ST &t feem

(B) HHH & WY T @™

(C) TTT-3TeTT SO 1 ForT LAl

(D) < OEHS® W & o I B
[EESEL TS

Excel § T 1 9T sl GUifad i
& foau f=fafea § 9 SA-w widse

ST foha Sran & ?

(A) F2
(B) F4
(C) F7
(D) F10

(15)

39.

40.

41.

Which Excel function is used to
calculate the average of a range of

values ?

(A) SUM

(B) COUNT
(C) AVERAGE
(D) MAX

Scatter Chart in Excel is primarily

used for :

(A) Displaying  proportions  of
categories

(B) Showing trends over time
(C) Comparing discrete categories

(D) Analyzing the relationship

between two quantitative

variables

Which of the following shortcuts is
used to edit the content of a cell in

Excel ?

(A) F2
(B) F4
C) F7
(D) F10
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42.

43.

44,

B170602T

g YR =t AR AF-aeleRd ad §
3R SrEwIfs S Wil & faw 3wdm
T S § 2

(A) ™

(B) W

(C) 3 FuRT

(D) =S fe=n

FHR &I fhy dE 4 e dfhed
(ICs) Rl 3TN Y& Tl ?

(A) el digl

(B) St e

(C) drd

(D) heft dic

PH-T FER AR B T T
FRfm i 9 TRfE & fo swEm
foren ST ® 2

(A) TTHH

(B) HRFIR

(C) THTA FHR

(D) ffoe

(16)

42.

43.

44,

Which type of memory is non-

volatile and is used for long-term data

storage ?

(A) RAM
(B) ROM
(C) Cache Memory

(D) Hard Disk

Which generation of computers

introduced the use of integrated

circuits (I1Cs) ?

(A) First Generation

(B) Second Generation

(C) Third Generation

(D) Fourth Generation

Which type of computer is used for

personal tasks such as browsing the

internet and word processing ?

(A) Mainframe
(B) Supercomputer
(C) Personal Computer

(D) Minicomputer
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45.

46.

47.

B170602T

F fawen ¥ 7€ few gra (HDD)
T YA HE FME 2

(A) =2 NI IR UM BT

(B) TrEfwIfier  (AM-dclesd)
SRSt HQIA oAl

(C) UM =M & foiw sTeemil f4
TS HET

(D) W& 3AYe/3MEee IUHRLUi 9
TR HIAT

Hed IERET e (CPU) &1 |MT Il
g:

(A) fefSea gz

(B) AN HUY

(C) HH =1 AR™h

(D) TR H<Ag

FR H ARfe faeen (0S) *1 g&=a

HE FT ?

(A) fa=n & TEFR AR HRSRR
GETEAT R GG AT

(B) TUSHERH &N Y Hl

(C) T IR Weeie s

o~

(D) 3ETIR HAfRIA

T Tefd sl

(17)

45.

46.

47.

The primary function of a hard disk
drive (HDD) in a computer system is
to :

(A) Perform data processing and
calculations

(B) Provide long-term (non-volatile)
data storage

(C) Offer temporary memory for
executing programs

(D) Interface with external

input/output devices

Central Processing Unit (CPU) is

considered as :

(A) Digital computer
(B) Analogue computer
(C) Brain of computer
(D) Power supply

The operating system (OS) in a
computer primarily functions to :

(A) Manage hardware and software
resources of the system
(B) Provide antivirus protection

(C) Create
spreadsheets

documents and

(D) Establish internet connectivity
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48.

49,

50.

B170602T

o oo~

Rl

SRV T ?
(A) fa=
(B) T
(C) =g
(D) T

frfafea § & ®F-o1 Sfow sqeam 49,

H Sriig-hrifesd &1 Iq@ STTHE § ?
(A) TS GrIntHT Arenstt 1 fase

(B) WM W= IR HE @

(aV o

SIEBIERIK

39T fordeh foru fopan ST & 2

(A) fifqss f=m 1 ereeA

(B) Sfas®k Ta 3R TEEHRI  H
fergereon e =amen

(C) Toaxita sAfyere =1 Jaied

(D) SiEifer Twm@fies A &
o

(18)

afed § § ®F- 3e feama s 48,

T SEiewbfer &1 gem o 90

Which of the following is an example
of an input device ?

(A) Printer
(B) Monitor
(C) Keyboard

(D) Speaker

Which of the following represents a

major application of bioinformatics in

biological research ?

(A) Developing new programming
languages

(B) Predicting protein structure and
function

(C) Designing mechanical devices

(D) Building
circuits

digital  electronic

Bioinformatics is primarily applied in
biology for :

(A) Studying physical laws

(B) Analyzing and interpreting

biological data and information

(C) Managing financial records

(D) Designing industrial chemical

compounds
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51,

52.

53.

54,

B170602T

20,480 foaieEe (KB) fohad #memse
(MB) & sRTeR 81T ?

(A) 5MB

(B) 10 MB

(C) 20 MB

(D) 40 MB

SPSS HieazR # Hifeaeha faveroor &
forT FF-91 22 TR Tod SUTH T 2

(A) W S (efed/ifean)
(B) THTHS TE&ATHE ST

(C) sTfaa fo= 2=

(D) == FaEa 2

SPSS H, hs-aRR qe0 Hid & fag
e gfaen 1 Swam fran ST e ?

(A) File > New > Chi-Square

(B) Analyze > Descriptive Statistics >
Crosstabs

(C) Edit> Options > Chi-Square

(D) View > Toolbar > Chi-Square

SPSS k1 WiafHer 3uAM fRuesh fog

o ST § 2

(A) SoE JeEH

(B) difed U

(C) dewrEe fashm

(D) wifes™ fagers

(19)

51.

52.

53.

54.

20,480 kilobytes (KB) is equal to how

many megabytes ?

(A) 5MB
(B) 10 MB
(C) 20MB
(D) 40 MB

Which type of data is most appropriate
for statistical SPSS

software ?
(A) Multimedia data (audio/video)

analysis in

(B) Quantitative numerical data
(C) Unstructured image data

(D) Raw signal data

In SPSS, which feature is used to
perform a Chi-square test ?

(A) File > New > Chi-Square

(B) Analyze > Descriptive Statistics
> Crosstabs

(C) Edit > Options > Chi-Square

(D) View> Toolbar > Chi-Square

What is SPSS primarily used for ?

(A) Database management
(B) Video editing
(C) Website development

(D) Statistical analysis
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55.

56.

S57.

B170602T

3 MS A # eTgia faawor drfereh

HY I THA § ?

(A) T giaem o1 TR I

(B) ¥ H B *I 3Tl €9 I T
HTh

(C) THele Zoret Hferen k1 ST shich

(D) Wi gfasn 1 ST &

Th €21 U & A fa=ed e &

T 39 HE-91 A heRE SYAN
FHT ?

(A) =STDEV()

(B) =AVERAGE()

(C) =SUM()

(D) =MEDIAN()

MS THIA & FifeTshid H1Et 1 ST

o o o

Hlch fefafed § 9 fwgeh! TFT i

SIRETIRI

(A) SITAT TR

(B) o¥rEd, mfewn, agaeh, IR AMS
IEENE

(C) i HueH

(D) R HYeHu

(20)

55.

56.

S57.

How can you create a frequency
distribution table in MS Excel ?

(A) By using the Sort feature

(B) By manually entering data into

cells

(C) By using the PivotTable feature

(D) By using the Merge feature

Which Excel function would you use
to calculate the standard deviation of a
dataset ?

(A) =STDEV()
(B) =AVERAGE()
(C) =SuM()
(D) =MEDIAN()

Which of the following can be
calculated using MS Excel’s statistical

functions ?

(A) DNA sequencing

(B) Mean, median, mode, and
standard deviation
(C) Gene editing
(D) Protein synthesis
Set-D
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58.

59.

60.

Which of the following is a
requirement for applying the chi-
square test ?

(A) The data must be categorical

(B) The data must be normally
distributed

(C) The data must be continuous

(D) The sample size must be small

What is the primary purpose of the
Chi-square test ?

(A) To find the median of a sample

(B) To calculate the mean of a data
set

(C) To test the association between
two categorical variables

(D) To determine the standard
deviation

What does the standard error of the
mean (SEM) represent ?

(A) The variability of the sample
mean estimate of a population
mean

(B) The total number of data points

(C) The range of the data

(D) The standard deviation of the
data set
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62.
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61.

62.

63.

What is the standard deviation ?

(A) A measure of the dispersion of
data points around the mean

(B) The average value of a dataset

(C) The highest value in a dataset

(D) The median of a dataset

What does the coefficient of variation
(CV) measure in a dataset ?

(A) The ratio of standard deviation
to the mean

(B) The difference between the
highest and lowest values

(C) The average of the squared
differences from the mean

(D) The sum of all data points

In a data set, the mode represents
which of the following ?

(A) The middle value
(B) The average of all values

(C) The value that appears most
frequently

(D) The difference between

maximum and minimum values
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65.

66.
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64.

65.

66.

What is the arithmetic mean ?

(A) The sum of all values divided by
the number of values

(B) The middle value in a sorted data
set

(C) The value that appears most
frequently in a data set

(D) The difference between the
highest and lowest values

Which of the following is NOT a
measure of central tendency ?

(A) Mode
(B) Mean
(C) Median
(D) Variance

What does a frequency distribution
represent in statistical analysis ?

(A) A summary of how often each
value appears in a dataset

(B) A method for calculating mean
values

(C) A step involved in hypothesis
testing

(D) A graphical tool for regression
analysis
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67.

68.

69.

In systematic sampling, how are

samples selected ?

(A) By stratifying the population and
selecting from each group

(B) By randomly picking individuals
from the population

(C) By choosing only the first
individuals

(D) By selecting every nth individual
from the population

What is stratified sampling ?

(A) Sampling only the first few
individuals

(B) Randomly selecting individuals
without any grouping

(C) Dividing the population into
subgroups and sampling each
subgroup

(D) Selecting every nth individual
from the population

What is random sampling ?

(A) Selecting samples based on

researcher preference

(B) A method where each member
of the population has an equal
chance of being selected

(C) A method used only for small
populations

(D) Choosing samples in a specific
sequence
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(B)
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(©)
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(A)
(B)
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(D)
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65
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In biometry, what is a population ?

(A) A collection of all individuals or
items under study

(B) A subset of a larger group
(C) A group of animals

(D) A sample of data points

When two fair six-sided dice are
rolled, what is the probability of
obtaining a total sum of 7 ?

(A) 5/36

(B) 6/36

(C) 7/36

(D) 1/12

A bag contains 3 red, 7 blue, and 10
green balls. If one ball is drawn at

random, what is the probability of
selecting a green ball ?

(A) 3/20
(B) 7/20
(C) 10/20
(D) 13/20

In the data set 45, 50, 55, 60, 65, what
is the median value ?

(A) 50
(B) 55
(C) 60
(D) 65
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74.

75.

76.

A study records the weights (in kg) of
8 patients as : 50, 55, 60, 65, 70, 75,
80, 85. What is the mean weight of the
patients ?

(A) 65kg

(B) 67.5kg

(C) T70kg

(D) 72.5kg

How can the limitations of statistics be
mitigated in life sciences research ?
(A) By avoiding data collection

(B) By ignoring statistical errors

(C) By using outdated methods

(D) By using rigorous data collection
and analysis methods

drawback of
methods in

What is a potential

relying on statistical

biological research ?

(A) Data may be misinterpreted if
not properly analyzed

(B) Statistics always provide
flawless conclusions
(C) AIll experimental errors are

removed through statistics

(D) Statistics are limited to use in
chemical studies only
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77.

78.

79.

What is a normal distribution often

referred to as ?

(A) Triangle curve

(B) Square curve

(C) Bell curve

(D) Zigzag curve

Which distribution is commonly used

in biostatistics for modeling binary

outcomes ?

(A) Normal distribution
(B) Binomial distribution
(C) Poisson distribution

(D) Exponential distribution

What does probability theory in

biostatistics helps to determine ?

(A) To visually display data for

easier interpretation

(B) The color of a flower

(C) The likelihood of an event
occurring

(D) The shape of an object
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81.

82.
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80.

81.

82.

Which of the following is a common

graphical representation used in
biostatistics ?

(A) Histogram

(B) Pie chart

(C) Line graph

(D) All of the above

What is the primary purpose
of  graphical representation in

biostatistics ?

(A) To visually present data for

easier interpretation

(B) To statistical

calculations

perform

(C) To collect experimental data

(D) To store data in databases

How is biostatistics applied in life

sciences ?

(A) To analyze experimental data

and draw conclusions

(B) To build computer software
(C) To design vehicles

(D) To construct bridges
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84.

85.
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83.

84.

85.

What is tabulation in the context of
biostatistics ?

(A) Arranging data in tables for easy
interpretation

(B) Writing novels
(C) Composing music

(D) Designing clothing

In biostatistics, classification refers to :

(A) Physical
samples in a laboratory

categorization  of

(B) Arrangement of data into
meaningful groups or classes for
analysis

(C) Graphical

variables

representation  of

(D) Statistical testing of hypotheses

Data compilation in biostatistics refers
to:

(A) Collecting and organizing data
for analysis

(B) Performing statistical tests
(C) Interpreting experimental results

(D) Presenting data graphically
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87.

88.
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86.

87.

88.

Which of the following is a commonly
used statistical method in biostatistics
for analyzing relationships between

variables ?

(A) Regression analysis
(B) Chromatographic separation
(C) DNA sequencing

(D) Image processing

What is the definition of biostatistics ?

(A) The analysis of financial markets
(B) The study of plant biology

(C) The application of statistics to
biological and health sciences

(D) The study of environmental

sciences

In bioinformatics, what does MSA
stand for ?

(A) Multiple Sequence Alignment
(B) Molecular Structural Analysis
(C) Medical Statistical Analysis

(D) Microbial Sample Analysis
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89.

90.

91.

What is multiple sequence alignment ?

(A) Editing
simultaneously

multiple images

(B) Aligning one sequence with a
3D model

(C) Aligning than  two

sequences to identify regions of

more

similarity

(D) Aligning chemical formulas

Needleman-Wunsch algorithm is used
for:

(A) Local sequence alignment
(B) Database searching
(C) Multiple sequence alignment

(D) Global alignment of biological
sequences

What is pair-wise sequence alignment

used for ?

(A) Creating 3D models

(B) Comparing two sequences to
identify regions of similarity

(C) Editing genetic material

(D) Conducting chemical reactions
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93.

94.
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92.

93.

94.

What is the main purpose of similarity

searching in bioinformatics ?

(A) To find similar sequences in a
database

(B) To edit biological images
(C) To create mathematical models

(D) To store financial data

What is the primary function of

ClustalW in bioinformatics ?

(A) Multiple sequence alignment of

DNA or protein sequences

(B) Sequence submission to

databases

(C) Genome annotation

(D) Protein structure prediction

Which method is commonly used for
protein sequencing ?

(A) Gel electrophoresis

(B) PCR

(C) Edman degradation

(D) Southern blotting
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95.

96.

97.

What is the primary goal of protein
sequencing ?
(A) To determine the sequence of

amino acids in a protein

(B) To create a digital image

(C) To measure the pH of a solution

(D) To edit genetic material

Which technology is commonly used
for high-throughput gene sequencing ?
(A) Sanger sequencing

(B) NGS

(C) Northern blotting

(D) Western blotting

What is the primary objective of gene

sequencing in molecular biology ?

(A) Editing digital images

(B) Determining the precise order of

nucleotides in a DNA sequence

(C) Measuring protein concentration

(D) Constructing phylogenetic trees

Set-D



98.

99.

100.

B170602T

frafafed 8 § -9 Td 2™ ¥
Sifereh STIRHI I JA: U A & o
AR TR ITART fohall S § 2

(A) T

(B) TS IR

(C) =

(D) THRTH

ARIShHIH e Seed | Entrez 9omed!
I g i = ?
(A)  STTRH TE HET

(B) TREE H Sfds®h WHHRI BIeHl
3R Tt LT

(C) 3OS JrAfET s

(D) WIfEHHTA TUFAT HIAT

BLAST o1 1 =19 1§ ?

(A) TEEfEE  deeE STeiied
foeen 7o

(B) wHAffSIohel  ol&  TATfAAd
A AIX 2HiTeh

(C) dfeh Tehel STaTETHE ¥4 2d

(D) dREhHCR difeed W 94
=gl

o

(34)

98.

99.

100.

Which of the following tools is

commonly used for retrieving

biological sequences from databases ?

(A) MATLAB

(B) Adobe Photoshop
(C) BLAST

(D) SRS

What is the primary role of the Entrez
system in bioinformatics databases ?

(A) Performing sequence alignment

(B) Searching and

biological data from databases

retrieving

(C) Processing images

(D) Performing statistical
tations

compu-

What does BLAST stand for ?

(A) Biometric Location Algorithm
System Tool

(B) Biological Lab
Software Technique

Analysis

(C) Basic Local Alignment Search

Tool
(D) Bioinformatics Logical Array
Search Tool
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